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2D MODEL IMPORT

2

Imported Model



Automatically divides the model into intersecting points

Example of Intersecting points

INTERSECT FUNCTION
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General steps for defining 

a specific soil material
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SOIL MATERIAL
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Truss Property

Plane Strain Property

Beam Property 5

SOIL PROPERTY
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Beam and Truss element comparison

Note: Spacing defines the distance 

between each individual element 

that will be generated along a line 

or curve when using truss-type 

elements. 6
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BEAM - TRUSS ELEMENT

Truss Library 



Soil property
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Ground Property

Structural Property

ELEMENT PROPERTY
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Face Function

Imprint Function
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GEOMETRIC MODEL
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Mesh size of 0.5 m

Mesh size control to increase the 

accuracy in plastic area
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MESH - SIZE CONTROL

9
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Generate mesh for soil layer 1

To show ‘Property color’

Display Mode (Mesh) → Property color

Soil 1
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MESH - GENERATE MESH
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‘Extract elements’ for retaining wall Note: By using the ‘Extract Elements’ 

function, it is needed to open geometry 

and corresponding mesh set
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MESH - EXTRACT ELEMENT
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INTERFACE
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Normal Stiffness Modulus (Kn) is the elasticity modulus for bonding and un-

bonding behavior in the normal direction to the interface element

 Shear stiffness modulus (Kt) is the elasticity modulus for slip behavior in the normal 

direction to the interface element

Kn = Eoed,i/ tv

Kt = Gi/ tv

Ci = R x Csoil

The general Virtual Thickness Factor range is 0.01 ~ 0.1 

(If the stiffness is high, use a smaller value)

Interface Wizard equation from Midas GTX NX manual

Where:

Kn: Normal Stiffness Modulus

Kt: Shear Stiffness Modulus

tv: Virtual Thickness Factor

R: Strength Reduction Factor

Ci: Interface Cohesion

Here,

Eoed,i= 2 x Gi x (1-vi)/(1-2 x vi)

Gi= R2 x Gsoil

Gsoil= E/(2(1+vsoil))

INTERFACE WIZARD

Strength Reduction Factor R

Sandy Soil/Steel Material 0.6~0.7

Clay/ Steel Material 0.5

Sandy Soil/ Concrete 0.8~1.0

Clay / Concrete 0.7 ~ 1.0
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Adjusting the RW local axis

Changing the axis of the local retaining wall axis
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LOCAL AXIS READJUSTMENT
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Merge node

Checking the merge node function for interface

Selecting all nodes → Mesh → Node → Merge → Find
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MERGE NODE
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Model Tree

NOTE: Step is generally done for organizing 

meshes
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MESH GROUPING

16



NOTE: Automatic constraint creates a fix restrictions (restrained x and y 

axes) on the bottom part of soil model, and pin restriction on the sides 

(restrained y axis).
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BOUNDARY CONDITION
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Define construction stage:

Stage Name → Set Data → Initial condition → Save → 

New
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CONSTRUCTION STAGE
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Stage 1: Initial Conditions
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CONSTRUCTION STAGE 1
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Stage 2. Install the retaining wall
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CONSTRUCTION STAGE 2

Stage 2: Retaining Wall
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Stage 3. Excavation for layer 1
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CONSTRUCTION STAGE 3

Stage 3: Excavation Layer 1
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Stage 4. Excavation for layer 2
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Stage 4: Excavation Layer 2

CONSTRUCTION STAGE 4
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Stage 5. Excavation for layer 3
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CONSTRUCTION STAGE 4

Stage 4: Excavation Layer 3
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23



Calculating with gravity method
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ANALYSIS CONTROL



Result → Advanced → Cutting 

Diagram
25 25
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RESULT - VERTICAL DISPLACEMENT



Bending moment 

Retaining Wall

Shear force 

Retaining Wall
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RESULT - BEAM STRESSES



Total Displacement 

Without RW

Total Displacement 

With RW

The comparison highlights the effect of the 

Retaining Wall in the excavation model. 27 27
27

RESULT - COMPARISON



DIFFERENT HAZARD 
CONDITIONS IN SLOPE 

STABILITY
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STRENGTH REDUCTION METHOD (SRM) 

In GTS NX, slope stability assessment uses the Strength Reduction Method (SRM), which 

determines the failure point by progressively reducing the soil's shear strength parameters. In 

this method, the soil's cohesion (c) and internal friction angle (φ) are systematically reduced 

using a reduction factor F; this reduction factor value is the safety factor (FoS).

The slope stability calculation depends on the soil strength, which in turn depends on the soil's 

cohesion and internal friction angle, as well as instability factors such as soil weight, water 

pressure, and external loads. Users can adjust the convergence criteria (load/displacement/work) 

in the analysis definition according to their preferences.

Reference

The intensity reduction method proposed by Griffith et al. (1999) and Matsui (1990)

Convergence adjustment

Resolution for FOS

the cohesion ÷ 1 and friction angle ÷ 1 

the cohesion ÷ 2.6and friction angle ÷ 2.6 



PSEUDO-STATIC SEISMIC

Pseudo-static seismic method is a simplified way to represent 

earthquake effects by replacing dynamic ground shaking with 

constant equivalent static forces

Applying inertial body forces proportional to gravity instead of time-

varying acceleration 

Reference

GTS NX/FEA NX/Soilworks Manual



SEEPAGE THROUGH UNSATURATED SLOPE

SEEPAGE INDUCED BY RAINFALL SURFACE RAINFALL 

OVER 72 HOURS



COMPARISON FOR DIFFERENT CASES

Normal case Heavy rainfall casePseudo-static seismic

FOS = 2.2883

FOS = 1.3922
FOS = 1.1469



Part 1 
NORMAL CONDITION



IMPORT

Parameter adjustment

Unit setting: KN/m/J/sec

Unit setting

2D Model

New file



2D MODEL IMPORT

Import CAD file name:

‘Geometry import’



MATERIAL & PROPERTY

Import all material properties



2D MESH GENERATION

Weathered Rock

Material Type : Mohr-Coulomb

Soft Rock

Material Type : Mohr-Coulomb

Weathered Soil

Material Type : Mohr-Coulomb

Mesh size: 0.5/ higher-order elements

Note: Using higher-order elements and smaller grid sizes for slope analysis



BOTTOM BOUNDARY

Bottom constraint Tx/Ty/Tz/Rx/Ry/Rz

The geometric features or nodes can be applied to the boundary



TWO-SIDED BOUNDARY

2-sided constraint Tx/Ry/Rz

It is recommended to set boundary sets for different location



SELF-WEIGHT



ANALYSIS 1 |SLOPE STABILITY (SRM) – NORMAL CASE)

Drag & Drop:

Mesh sets / Boundaries / Load sets

Simulation type: Slope Stability(SRM)



Convergence settings

SRM convergence adjustment

(1) Initial safety factor 1

(2) FOS increment by 0.1 each time

(3) Residual < 0.01, minimum FOS reached

Output=>Strain

Shear strain indicates the failure arc

Output setup

ANALYSIS 2 |SLOPE STABILITY (SRM) – NORMAL CASE)



CALCULATION

Execute the analysis case



SAFETY FACTOR INDICATION | CONVERGENCE CRITERIA

Initial FOS = 1

Increasing FOS = 0.1 each time
A residual < 0.01 indicates 

FOS has been reached

SRM convergence setting

(1) Initial safety factor 1

(2) FOS increment by 0.1 each time

(3) Residual < 0.01, minimum FOS reached



RESULTS | NORMAL CASE

SRM for safety factor calculation

Self-weight analysis, FOS = 2.2883

Tx Translation(m)

Maximum Shear Strain

Failure surface indicated by horizontal 

displacement & maximum shear strain



Part 2 
PSEUDO-STATIC 
SEISMIC CASE



HORIZONTAL SEISMIC COEFFICIENT (KH)



VERTICAL SEISMIC COEFFICIENT (KV)



ANALYSIS 1 | PSEUDO-STATIC SEISMIC CASE

Drag and drop: mesh set/boundary set/load set

Seismic slope stability analysis:

Slope stability(SRM)



ANALYSIS 2 | PSEUDO-STATIC SEISMIC CASE

Convergence settings

SRM convergence adjustment

(1) Initial safety factor 1

(2) FOS increment by 0.1 each time

(3) Residual < 0.01, minimum FOS reached

Output: Strain

(Shear strain indicates the failure arc)

Output setup



CALCULATION



RESULTS | PSEUDO-STATIC SEISMIC CASE 

Pseudo-static seismic by kh & kv, 

FOS = 1.3922 
Tx Translation(m)

Maximum Shear Strain

Failure surface indicated by horizontal 

displacement and maximum shear strain

SRM for safety factor calculation



Part 3
HEAVY RAINFALL 

CASE



Coefficient of 
permeability(K)

(m/sec)

Specific Storativity(Ss)
(1/m)

Weathered Soil 10-5 - 10-3 10-6 - 10-3

Weathered Soil

POROUS MATERIAL 1 | WEATHERED SOIL

Loam Data

Reference: Van Genuchten date (Carsel and 

Parrish,1988)

Material database in GTS NX

Note 1: The relevant parameters use assumed conditions.

Note 2: Unsaturated parameters are not defined in the seepage calculation process; the soil is treated as saturated.



Coefficient of 
permeability(K)

(m/sec)

Specific Storativity(Ss)
(1/m)

Weathered Rock 10-6~10-4 10-6 ~10-3

Weathered Rock

Van Genuchten date (1980)

Sandstone (Hygiene)

Material database in GTS NX

Note 1: The relevant parameters use assumed conditions.

Note 2: Unsaturated parameters are not defined in the seepage calculation process; the soil is treated as saturated.

POROUS MATERIAL 2 | WEATHERED ROCK



Coefficient of 
permeability(K)

(m/sec)

Specific Storativity(Ss)
(1/m)

Soft Rock 10-6~10-4 10-6 ~10-3

Soft Rock

Flow of rainfall case does not calculate as saturated

Note 1: The relevant parameters use assumed conditions.

Note 2: Unsaturated parameters are not defined in the seepage calculation process; the soil is treated as saturated.

POROUS MATERIAL 2 | SOFT ROCK



IN-SITU RECORDED RAINFALL | HOURLY RAINFALL

Seepage Boundary

72 hours rainfall variation

Excel data Copy & paste the data

Unit (kn/m/J/hr)

註:GTS NX不支援Y軸單位切換。



SURFACE FLUX
Seepage/Consolidation Analysis

Flux = Value × Function

Setting:

if surface flux > coefficient of permeability

total head = potential head



REVIEW / SEEPAGE

Seepage/Consolidation Analysis



CONSTRUCTION STAGE 1 | PSEUDO-STATIC SEISMIC CASE

Construction phase types in GTS NX

Fully Coupled Stress Seepage

Step2.Define CS

Construction stage definition

Activate all mesh sets/boundary sets

Step1. Seepage_SRM_Direct



CONSTRUCTION STAGE 2 | FULLY COUPLED STRESS SEEPAGE

Select SRMSelect all set types

(Even kh/kv for simulation)

Analysis setting

Time control assignment

Ignore initial water leve

l



Convergence criteria tolerance

CONSTRUCTION STAGE 3 | ANALYSIS & CONTROL

Select



CONSTRUCTION STAGE 4 | ANALYSIS CONTROL/ TIME CONTROL

72 Hours With 24 Steps Of Calculation

Time Step

SRM convergence adjustment

(1) Initial safety factor 1

(2) FOS increment by 0.1 each time

(3) Residual < 0.01, minimum FOS reached



ANALYSIS | HEAVY RAINFALL CASE

Construction Stage

Construction Stage: 72hr of heavy rainfall analysis



CALCULATION

執行求解

進行連續降雨邊坡滲流應力耦合計算



Seepage-stress coupling analysis

SRM analysis results

DIRECT METHOD ANALYSIS RESULTS 

Each time step of calculation

SRM is calculated from the last step



ANALYSIS RESULTS | HEAVY RAINFALL CASE

Tx Translation(m)

Maximum Shear Strain

Heavy rainfall simulation, FOS = 1.1469

Failure surface indicated by horizontal displacement 

& maximum shear strain

SRM for safety factor calculation
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